
	

Continue

29479502.092593	118451604516	24983467828	68985931880	43928371.868421	10582594.953125	25759190144	25121716.903614	57642872.684211	334293174.5	21292890.077922	35051709	94151861179	120965348378	2354791.7875	25378127.48	48639044919	18743557.466667	23048384.844444	4349036903	15398295.575	115776253257
59389567484	22871667.153846

https://podar.co.za/XSRYdR1H?utm_term=agisoft+metashape+pro+manual


Agisoft	metashape	pro	manual

Agisoft	metashape	best	settings.	Agisoft	metashape	review.

In	the	left	panel,	select	"Draw"	tab>	Ã	¢	â,	¬	Å	"Editor	â,	¬	tab>	Make	sure	that	NVIDIA	Iraray	is	selected	as	the	drawing	style	at	the	top	of	the	left	panel,	Select	"Jave	Configuration">	Ã	¢	â,	¬	å	"Editor	Ã	¢	Ã	¢	Ã	¢	â,	Ã"	Filtering	'Menu	Make	sure	that	both	Ã	¢	¬	Å	"Post	Denoiser	available	â,	¬	and	Ã	Â,	¬	Å	"Post	Denoiser	enabled	¬	¬	are	configured
in	Ã	¢	â,	à"	OnÃ	¢	â,	¬	¬	¬	¬	¬	Å	"Location	of	the	default	application	and	the	executable	program	c:	\	Program	Files	\	Dxo	\	Nik	collection	N	\	Instructions	Analog	Efex	Pro	4.exe	Select	the	configuration,	expand	the	GPU	tab,	select	"GPU	Using	for	image	processing.	EFEX	Pro	4.exe	Instructions	Select	the	configuration,	expand	the	GPU	tab,	Select
"Using	GPU	for	the	processing	of	images.	Location	of	the	default	application	and	executable	name	C:	\	Program	Files	\	DXO	\	NIK	Collection	N	\	HDR	EFEX	Pro	2.exe	Instructions	Select	the	configuration,	expand	the	GPU	tab,	select	"GPU	Usage	for	processing	The	image	"default	application	and	executable	name	C:	\	Program	Files	\	DxO	\	Nik
collection	\	Silver	EFEX	Pro	2.exe	instructions	Select	the	configuration,	former	PANG	GPU	Tab,	select"	GPU	Usage	for	The	processing	of	images,	the	default	location	of	the	application	and	the	executable	name	C:	\	Executing	Files	\	DXO	\	DXO	Photolab	4	\	dxo.photolab.exe	Instructions	(Note:	NVIDIA	GPU	is	not	available	to	select	in	UI	Until	after	the
first	application	close):	In	global	navigation,	select	"ADERDES"	and	select	"Preveritias",	from	the	drop-down	menu,	select	the	"Encoreance"	tab	below	the	"Time	Accelection,	select	the	NVI	GPU	day	under	Ã	¢	â,	¬	å	"Display	and	Process,	Ã	¢	Ã	¢	â,	¬	Å"	Enable	OpenLÃ	â,	¬	Location	of	the	default	application	and	executable	name	C:	\	Files	\	ELGATO	\
GameCapture	\	GameCapture.exe	Instructions	Click	on	the	configuration	of	the	UI	icon	from	the	top	right	of	the	UI.	Select	"Advanced",	Ã	¢	â,	¬	å	"Video	codecÃ	â,	Ã	Ã	Ã	â,	¬	å"	DecoderÃ	â,	¬	-	Select	Nvidia	GPU	Ã	¢	Ã	Â,	Â	¢	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Ã	Â,	¬	¬	¬	¬	¬
¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	¬	âinate	Set	the	location	of	the	predetermined	application	of	the	top	quality	"	and	the	predetermined	quality.	Executable	Name	C:	\	Program	Files	\	Nuke13.0v1	\	Nuke13.0.exe	Instruction	Instructions	SELECT	SELECT	SELECT	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	"Global	Navigation
Select	Ã	¢	Ã	¢	¬	Å	"PreferencesÃ	¢	â,	¬	on	the	left	side	NAV	under	Ã	¢	â,	¬	Å"	PerformanceÃ	â,	¬	Ã	¢	Ã	â,	Ã	Ã	"	"Default	Flobk	Device	¢	â,	¬	-	Select	Nvidia	Default	GPU	The	location	of	the	application	and	the	executable	name	C:	\	Program	Files	(X86)	\	GameCaster	\	GameCaster.exe	Instructions	Select	the	configuration	icon	at	the	bottom	right
Select"	Advanced	"Tab	Processing	Mode:	Select"	Standard	(Use	GPU)	"Location	of	the	default	application	and	executable	name	C:	\	Program	Files	\	Gimp	2	\	Bin	\	GIMP-2.10.exe	Instructions	Enable	experimental	features	Make	Click	with	the	right	button	on	the	GIMP	shortcut	on	your	desktop	and	select	"Properties",	select	the	"Bshortcut"	tab,	and
Paste	"-	-	Spectacle	-PlayGround:	at	the	end	of	the	text	in	the	text	box	of	Destination	of	global	navigation,	select	"ADERDES"	Drop-down	Menu	Select	"Preversure	S	""	Navigate	to	the	Hardware	acceleration	of	the	eye	tab.	â,	¬	â,	Ã	â,	¬	å	"ONCLÃ	â,	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	UI	in	the"	general	"tab,	select"	CLEAR	"icon	under	the	location	of	the	GPU
predetermined	application	and	the	Executable	Name	%AppData%	\	Keyshot	##	\	Bin	\	KeyShot.exe	Instructions	>>	Edit	>>	Preferences	-	Verification	of	the	interface:	Use	GPU	(get	effects)	Use	GPU	to	click	on	the	"GPU"	button	on	the	Menu	of	upper	tape.	Project	dependence:	When	creating	a	substance	user	you	must	select	Rendere	in	the	window,
and	choose	Default	Iraq	Location	of	application	and	executable	name	C:	\	Executing	Files	\	Allegoríthic	\	Substance	Painter	INSTRUCTIONS	Enable	GPU	Raytracing	In	general	->	Baking	options	=	Checked	in	case	of	default	scroll	down	to	"Hardware	Right"	Select	the	CPU	options	and	GPU	GPU.	The	global	navigation	menu,	select	Select	"Sushing"	to
La	Opción	"Processer	of	licenses,	asegees	of	The	NVIDIA	GPU	is	selected	V	Location	of	the	default	application	and	the	executable	name	C:	\	Program	Files	\	Topaz	Labs	LLC	\	Topaz	Gigapixel	AI	\	Topaz	Gigapixel	Ai.exe	Instructions	Start	Application	from	the	Global	Navigation	Mode,	select	"File	"Drop-down,	select	Ã	¢	â,	Å"	preferences,	¬	under	the
application,	to	Ã	¢	â,	¬	Å	"maximizes	the	AI	​​quality	models:	radio	button	Ã	¢	â,	¬	Å"	onÃ	¢	Â,	Â	¢	â,	¬	å	"Enable	GPU	discrete,	â,	¬	=	Radio	button	Ã	¢	¬	Å"	The	default	application.	Location	and	executable	file	C:	\	Program	Files	\	Topaz	Labs	LLC	\	Topaz	Video	Enhancement	Video	AI	\	Topaz	Improve	instructions	AI.EXE	Start	application	from	the
global	navigation	menu,	select	"File"	drop-down,	select	"SPREEFERS".	The	Ã	¢	¬	Å	"to	processor	option,	make	sure	that	the	NVIDIA	GPU	is	selected	the	default	location	of	the	application	and	the	name	of	the	executable	C:	\	Executing	Files	\	Topaz	Labs	LLC	\	Topaz	Studio	2	\	Topaz	Studio	2.Exe	Instructions	No	GPU	options,	to	see	what	GPU	is	being
used,	select	Global	Navigation	Help	and	select	"Staple	Information",	default	application	and	executable	name	C:	\	P	files	Glogram	\	Epic	Games	\	TwinMotion20	##	\	TwinMotion.exe	Instructions	Select	Ã	¢	â,	¬	å	"EditÃ	¢	â,	¬	¬	¬	Å"	PreferencesÃ	¢	â,	¬	Ã	¢	Ã	¢	Å	"Quality	¢	¬	¬	of	upper	navigation:	select"	automatic	confetilla	".	â,	¬	Location	of	the
default	application	and	executable	name	C:	\	Users	\	"PC	name	'\	Appdata	\	Roaming	\	Twitch	Studio	\	Bin	Instructions	Select	File	->	Ã	¢	â,	¬	å"	SettingsÃ	¢	â,	¬	in	the	Top	right	of	the	screen	Select	Ã	¢	â,	Å	"Strete	'of	the	menu	encoder	->	Select	NVIDIA	event	(automatically	selected)	Configuration	configured	by	default	is	a	predetermined	location	of
application	and	name	C:	\	Program	Files	\	Unity	\	Hub	\	Editor	\	20	##	\	Editor	\	Unity.exe	Each	compilation	has	a	different	version	of	the	version	of	the	folder	Create	a	new	project	3D	Select	Ã	¢	â,	¬	Å	"Window	Ã	¢	¢	¬	¬	deplegable	menu,	fleet	on	Ã	¢	â,	¬	"Rrendering	'and	select"	Light	Settings	".	Select"	Tap	".,	Scroll	down	and	select"	Progressive
GPU	(Preview)	""	LightMapper	"A"	Denoisedirect	Denoise,	"select"	Opticion	"."	Opticion	".	DenoiseÃ	¢	â,	¬	Ã	¢	Ã	¢	¬	å	"PTIXÃ	¢	â,	¬	¬	à"	Auto	Generate	'at	the	bottom	of	the	window	download	instructions	and	install	V-Ray	GPU	Next	Add	to	3DS	Max	Lake	3DS	MAX	TIP	F10	(or	click	on	the	Render	configuration	icon)	to	open	the	"Render	Settings"
window	then,	select	"V-Ray	GPU	Next,	update	2,	¬.	Select	Ã	¢	â,	Å	"Auto	¢	â,	to	the	GPU	processing	mode	and	the	GPU	selection	decoding	options	tab	Select:	Use	GPU	for	Decodish	Decodish	Decode	Select	Decodish	H.264	/	H.265	using	the	Hardware	acceleration	use	GPU	for	R3D,	select	drop-down	menu	and	select	Ã,	â,	Å	"DecompressiÃ"	n	and
debayer:	Location	of	the	default	application	and	executable	name	c:	\	Daz	3D	\	Applications	\	64-bit	\	Daz	3D	\	Dazstudio4	\	Dazstudio.exe	Instructions	In	the	left	pane,	select	"Render	configuration"	tab>	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	\	denoising:	Select	the	final	color	output	on	the	Denoising	NVIDIA	OptiX	shading	switch	to	NVIDIA	OPTIX.	Location	of
application	and	executable	name	C:	\	Program	Files	\	Ndi.TV	\	NDI	4	Tools	\	Studio	Monitor	\	Application.network	.studiomonitor.x64.exe	During	the	installation	Make	sure	the	following	tools	are	selected.	Ã	¢	â,	¬	Å	"SettingsÃ	â,	¬	->	Ã	¢	â,	¬	å"	VIDEOÃ	¢	â,	¬	and	select	Ã	¢	â,	¬	Å	"ALLOW	HW	accelerationÃ	¢	Ã	¢	Ã	¢	â,	¬	EXE	instructions	Select	The
Ã	Ã	¢	â,	Å	"SettingsÃ	¢	button	on	the	lower	right	part	of	the	screen	Select	the	Ã	¢	Ã	¢	â	€"	outputÃ	¢	section.	On	the	left	side.	Red	for	dynamics,	blue	for	animation.	In	the	output	mode,	select	"Advanced"	on	the	encoder	transmission	tab:	select	Ã	¢	â,	¬	Å	"Hardware	(Government)	Ã	â,	Ã	Ã	Ã	Ã	â?	,	¬	¬	â,	¬	in	the	instance	of	visual	pyycho	rotating	and
looking	forward	Max	B-Flames	->	3	Other	configurations	in	default:	Speed	​​control:	CBR.	Select	the	V-Ray	tab.	Location	of	the	default	application	and	executable	name	C:	\	Program	Files	(X86)	\	Videolan	\	VLC	\	vlc.exe	Instructions	Select	Ã	¢	â,	à	"ToolsÃ	¢	â,	¬	of	the	Global	Navigation	Measure	Select	Ã	¢	Â,	¬	å	"PreferencesÃ	¢	â,	¬	¬	¬	¬	¬"	/
CodecsÃ	â,	¬	".	Excused	decoding	tab	by	the	descent	tab,	select	"Firect3D11	video	acceleration"	Default	Location	of	application	and	executable	name	C:	\	Executing	files	\	Chas	Group	\	V-Rays	\	Standalone	for	x64	\	bin	\	vray_gpu_device_select	.Exe	Instruction	Start	Instructions	Select	the	application	The	NVIDIA	GPU	device	deletion	CPU	Select:	Ã	¢
â,	¬	Å	"Sets	the	output	application	after	the	confirmation	text	appears	the	path	of	the	application	C:	\	Program	Files	(	X86)	\	SplitMediaBS	\	Xsplit	broadcaster	\	x64	\	xsplit.core.exe	Global	navigation	instructions	Ã	¢	¬	Å	"ToolsÃ	¢	¬	¬	¬	dropdown,	select"	Sampling	",	select"	Advanced	"processing	mode	of	Video	Tab:	Select	"GPU	GPU	for	video
processing,	select"	WOK	"GPU	processing	mode	-	Select"	GPU	selection	mode	¬:	Select	"Auto"	Select	Use	tabs	Decoding	D.	E	GPU's	isrships,	select:	Use	GPU	for	Decodish	RAW	BlackMagic	Use	GPU	for	R3D,	select	DROP	DOWN	MENU	and	select	"Decompression	and	debayer.	Memory	and	GPU	tab,	GPU	configuration	section.	This	opens	the
properties	of	this	article.	Then,	you	can	select	your	NVIDIA	RTX	GPU.	Enabling	the	Accelerated	GPU	generation	Location	of	the	default	application	and	the	executable	name	C:	\	Program	Files	\	Autodesk	\	3DS	Max	20	##	\	3dSmAx.exe	Instructions	Troubles	F10	key	or	select	the	Render	configuration	icon	in	the	bar	of	Top	Menu	Objective:	Select
Production	Mode	â,	¬:	Select	"Encardend"	Render	device:	Select	"Sub"	Sub	tabs:	Select	"System"	tab	Select	"Sleeping	MONOUAL	Device,	select	the	Nvidia	GPU	(S)	lens:	Select"	Mode	of	Interactive	Representation	"Render:	Select"	Ingar	"sub	tabs:	tabs:	Ã	¢	â,	Å	"SystemÃ	¢	â,	¬	Rens	device:	Select"	GPU:	Select	"Monaural	device	selection"	Select
NVIDIA	GPU	(s)	Objective:	Select	"Shadow	Mode	Active	"Render:	Select"	Set	"Set:	Select"	System	"Render	device:	Select"	Select	"Select"	Selection	of	monaural	devices	"Select	Nvidia	GPU	(s)	)	Default	Location	and	executable	name	C:	\	Program	Files	\	Adobe	\	Adobe	After	Effects	20	##	\	Support	Files	\	AFTERFX.EXE	INSTRUCTION	FILE	->	Project
configuration	->	Use	of	playback	and	video	effects	-	Mercury	GPU	acceleration	(CUDA)	Location	of	the	default	application	and	executable	name	C:	\	Program	Files	\	Adobe	\	Adobe	Bridge	202	#	\	Bridge.exe	Instructions	Expand	Ã	¢	â,	Å	"EditÃ	¢	Drop-up,	select	Ã	¢	â,	¬	Å	"Preference,"	Advanced	tab,	select	"Previous	previews	of	generated	monitors:
Pestaã	±	a	cache,	select	Ã	¢	â,	à	"cache	cache	at	the	exit	of	the	tiny	tag,	deselecting"	generation	of	miniature	miniatures	on	the	preview	generation,	the	predetermined	location	of	the	application	and	the	name	executable	c:	\	execution	files	\	adobe	\	adobe	dimension	\	dimension.exe	instructions	Select	the	show	/	hide	r	Preview	icon	from	Ender	at	the
top	right	of	the	Render	Preview	window	Select	selection	button	Ã	¢	,	¬	å	"Enviable	the	upper	navigation	bar,	Ã	¢	â,	¬	Å"	Ditin	'Drop-down	Menu	and	select	Ã	¢	â,	¬	å	"PreferenceÃ	¢	â,	¬,	move	down	and	make	sure	that?	Å	"Reduces	noise	in	the	provision,	the	default	location	of	the	application	and	executable	name	C:	\	Program	Files	\	Adobe	\	Adobe
Illustrator	20	##	\	Support	Files	\	Contexts	\	Windows	\	Illustrator.exe	>	Edit	>>	Preferences	-	Performance	SELECT	Ã	Ã	â,	¬	Å	"GPU	PerformanceÃ	â,	¬	Ã"	Nimated	â,	¬	Select	Ã	¢	Ã	¢	¬	å	"Real-Time	Drawing	and	edition	¢	â,	¬	Click	OK	to	apply	after	opening	/	Create	a	superior	menu	of	the	project	view	->	Click	on"	Vista	using	GPU	"Location	of	the
default	application	and	executable	name	C:	\	Program	Files	\	Adobe	\	Adobe	Lightroom	CC	\	LIGHTROOM.EXE	INSTRUCTIONS	Edit>	Preferences>	Performance	Use	Graphic	Processor>	Check	custom	Ã	¢	â,	Å"	Use	GPU	to	show	¢	â,	¬	"Use	GPU	for	image	processing:	Location	of	the	default	application	and	executable	name	C:	\	Program	program
Lightroom	Classic	\	Lightroom.exe	Instructions	Edit>	Preferences>	Raw	Performance	Chamber:	Use	Graphic	Processor>	Check	custom	Ã	¢	â,	Å	"GPU	use	to	show	â,	¬	Ã	¢	Ã	¢	Ã	¢	Ã	¢	Use	GPU	for	the	processing	of	images	...	Ã	¢	â,	¬	of	the	default	application	Location	and	executable	Name	C:	\	Program	Files	\	Adobe	\	Adobe	Media	Encoder	20	##	\
Adobe	Media	Encoder.exe	Instructions	Top	Navigation	N,	edit	->	General	preference	->	Video	representation	Select	Mercury	Motor	GPU	Acceling	(CUDA)	Default	application	Location	and	executable	file	C:	\	Program	Files	\	Adobe	\	Adobe	Photoshop	20	##	\	Photoshop.exe	Instructions	Edit	->	Preference	-	>	General	->	The	performance	use	graphics
processor	must	be	checked	(automatically)	Click	Advanced	Configuration.	You	should	see	a	blue	bar	filled	in	the	timeline.	Select	the	tab	"tab"	and	expand	the	"V-Ray	Ray	GPU	Renderer	Select"	section.	INSTRUCTIONS	Download	and	install	V-Rayg	GPU	Next	add-on	for	Maya	Lanzg	Maya	in	Maya,	select	Render	settings.	In	the	sub-tab	configuration,
select	your	ray	tracking	engine.	To	turn	on	the	cache	storage:	Left	click	on	the	cache	storage	icon.	Location	of	the	default	application	and	executable	name	C:	\	Program	Files	\	Autodesk	\	Revit	20	##	\	Revit.exe	Instruction	File	->	Options	Hardware	Top	Verification	-	Ã	¢	â,	¬	Å	"Use	Hardware	Acceleration	Â,	¬	-	Ã	¢	â,	¬	å	"Draw	only	Visible	elements,
¬	¬	Verification	of	the	User	Interface	tab:"	Use	the	hardware	graphics	acceleration	if	it	is	available	Location	of	the	application	Default	and	executable	name	C:	\	Executable	files	\	Blender	Foundation	\	Blender	2.	Instructions	##	\	blender.exe	Top	Navigation	bar,	Ã	¢	â,	Å	"EditÃ	¢	â,	DOWN	menu	and	select"	Preferences	",	select"	"From	the	navigation
on	the	left	side,	select"	Settime	tab	"under"	Render	Devices	",	select	the	Render	Properties	tab,	in"	Render	Motor:	Select	"Cicycles"	and	"Device",	select	"	Compute	Compute	"By	Defasion	by	Defancy	and	Executable	Name	C:	\	Program	Files	\	Maxon	Cinema	4D	R	##	\	Cinema	4d.exe	Instructions	Preferences	->	Substance	Engine	Tasting	in	the
Substance	Engine	Section	of	the	switch	running	4D	4D	cinema	->	Select	GPU	-	Direct	3D	11	Global	NAV,	Render	->	Edit	Render	Render	Drop	Down	->	Prorender	->	General	tab	Devices	->	Check	"Global	Device	Configuration"	on	Offline	Devices	->	Check	the	GPU	low	Preview	devices	->	Mark	the	GPU	NOTE:	Accelerator	brush	(the	reference	tool	in
the	application	must	be	executed	before	the	GPU	can	be	selected	in	the	application	menu)	location	of	the	default	application	and	the	executable	name	C:	\	Program	Files	\	Corel	\	Pinter	20	##	\	Painter	20	##	x64.exe	Instructions	Select	Ã	¢	Ã	¢	Ã	¢	â,	à	"EditÃ	â,	¬	of	the	global	navigation	menu,	fleet	on	Ã	¢	â,	¬	Å"	PreferencesÃ	¢	â,	¬	and	select	Ã	¢	â,
¬	å	"PerformanceÃ	â,	¬	Å"	Run	accelerator	brush	¢	â,	¬	Select	Ã	¢	â,	¬	Å	"Use	the	graphic	processor	(GPU	)	To	accelerate	the	performance	of	the	brush)	Select	the	NVIDIA	GPU	from	Ã	¢	â,	à	"Configure"	Menu	Despandable	Application	Default	application	of	application	and	executable	name	C:	\	Program	Files	\	Corel	\	CorelDRAW	Graphics	Suite	20
##	\	Programs64	\	CORELPP.EXE	instructions	Select	the	COG	configuration	icon,	select	"Government"	Select	"Use	GPU	to	accelerate	The	application	by	default.	Exposure	and	executable	files	c:	\	Program	Files	\	Corel	\	CorelDRAW	Graphics	Suite	20	##	\	Programs64	\	coreldrw.exe	Instructions	Select	the	COG	configuration	icon,	select	"Gobo",	select
"GPU	to	accelerate"	by	default	location	The	application	and	executable	name	C:	\	Users	\	NVIDIA	\	APPDATA	\	Roaming	\	D5	Render	\	d5	\	d5_lacheryer.exe	Instructions	for	GPUS	RTX,	select	the	DLSS	tab	at	the	top	of	the	user	interface	and	select	"NVIDIA	DLSS	ON	"Location	of	the	default	and	executable	application	name	C:	\	Program	Files	\
Blackmagic	Design	\	DAVINCI	RESOLVE	\	Resolve.exe	Davinci	Resolve	Global	NAV	->	Memory	of	preferences	and	GPU	tab,	GPU	configuration	section.	Location	of	the	default	application	and	executable	name	C:	\	Executing	files	\	Vegas	\	Vegas	Pro	###	\	vegas180.exe	Instructions	from	Global	NAV,	select	Ã	¢	Ã	â,	Ã	¢	Ã	¢	â,	¬	"Pull	Down	and	select	Ã
¢	â,	Å	"PreferenceÃ	¢	â,	Ã	¢	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã"	Use	GPU	for	Processing	for	AcesÃ	¢	color	Management	â,	¬	Select	the	tab	"VIDEOÃ	â,	¬,	in	the	video	acceleration	of"	GPU	"GPU	SELECT	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	"Ã	Ã	Ã	Ã	Ã	Ã	Ã"	Ã	Ã	Ã	Ã	"Ã	Ã	Ã	Ã	Ã"	Ã	Ã	Ã	Ã	Ã	"Ã	Ã	Ã	Ã	Ã"	Ã	Ã	Ã	Ã	Ã	"Ã	Ã	Ã	Ã
Ã	Ã"	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	"Ã	Ã	Ã	Ã	Ã	Ã	Ã"	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	âinate	Start	Instructions	Application	Expand	Ã	¢	â,	¬	å	"Global	navigation	menu	and	select	Ã	¢	â,	¬	å"	Preferences	¢	â,	¬	for	Non-Pascal	GPUs	10xx	/	No	RTX	(legacy)	for	Pascal	10xx	/	RTX	GPUS	Location
of	the	default	application	and	the	executable	name	C:	\	Program	Files	\	Foundry	\	Mode	\	14.0v2	\	mode.exe	Instructions	in	the	Shader,	select	your	providing	the	article.	Then,	in	the	"Ingenio	Type"	field,	select	"RTX"	and	under	"Loslevice	Name",	select	the	NVIDIA	RTX	GPU	that	you	have	installed.	Select	the	fall	of	the	GPU	processing	mode,	select	the
CUDA	Decode	options	tab,	select:	Use	GPU	for	Decodish	de	Decodación	RAW	BlackMagic	Select	Decoding	H.264	/	H.265	Using	Hardware	acceleration	Use	GPU	for	R3D,	Select	Deslagrire	the	menu	and	select	"Decompression	and	debayer.	Â,	¬	Location	of	the	default	application	and	executable	name	C:	\	Program	Files	\	Blackmagic	Design	\	DAVINCI
DOWN	\	RESOLVE.EXE	DAVINCI	INSTRUCTIONS	RESOLVE	GLOBAL	DISPLAY	->	Preferences	memory	and	GPU	tab,	GPU	configuration	section.	Select	"Auto"	next	to	the	GPU	processing	mode	and	the	GPU	selection	options	tab,	select:	Use	GPU	for	RAW	BLACKMAGIC	DECODIFICATION	USE	GPU	for	R3D	,	Select	Drop-down	Menu	and	select	the
location	of	the	default	application	of	the	application	and	the	debayer	application.	Executable	Name	C:	\	Program	Files	\	Blackma	GIC	Design	\	DAVINCI	RESOLVE	\	Resolve.exe	Instructions	DAVINCI	RESOLVE	GLOBAL	VAIL	drop-down	->	Preference	memory	and	GPU	tab,	GPU	configuration	section.	The	CPU	and	the	acceleration	of	OPTIX	Prime	are
unchecked.	Leave	other	configurations	Default:	Select	Quality	Profile	Control:	CQP.	Select	Use	the	graphic	processor	to	speed	up	the	calculation,	use	the	OPENCL	guides	and	anti-alias	guides	and	the	default	application	location	and	the	executable	name	C:	\	Executing	Files	\	Adobe	\	Adobe	Premiere	Pro	20	##	\	Adobe	Premiere	Pro.exe	Instructions
When	starting	a	new	project	-	Select	the	GPU	acceleration	of	the	Mercury	playback	engine,	from	the	"Redinger"	field	when	using	an	existing	existing	-	Superior	navigation	bar,	Ã	¢	â,	¬	Å	"FileÃ	¬	deplegable,	Ã	¢	â,	¬	Å"	Project	'Settings	â,	¬,	Select	"GeneralÃ	¢	â,	¬	Select	the	acceleration	of	the	GPU	Reproduction	Engine	(CUDA)	"of	the"	CUDA)	"of
the	Ã	¢	â,	¬"?	Propulating	Presentation	by	Field	Location	and	Executive	Name	C:	\	Executing	Files	\	Program	Files	\	Affinity	\	Designer	\	Designer.exe	Start	Instructions	Application	Expand	Ã	¢	Ã	¢	¬	Å	"Global	navigation	and	select	Ã	¢	â,	¬	å"	Preferences	â,	¬	Ã	¢	â,	¬	Å	"PerformanceÃ	â,	¬	Make	sure	that	Ã	¢	â,	¬	"Old	Quality"	=	Ã	¢	â,	Å	"Bilinear
(Best	quality)	Ã	¢	Ã	¢	¬	Å"	DÃ	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	¢	â,	¬	=	proven	Ã	¢	Ã	¢	¬	å	"RendererÃ	¢	â,	¬	=	nvidia	gpu	Ã	¢	â,	¬	Å	"Retina	representation,	¬	=	Ã	¢	â,	¬"	Automatic	(Better)	Ã	¢	â,	¬	å	"Hardware	Acceleration:	Enable	Computer	Cumping	acceleration	Ã	¢	â,	¬	=	Revision	of	the	default	application	Location	and	the	name	of	the	executable	C:	\
Executing	Files	\	Affin	Uity	\	Photo	\	Photo.exe	Start	instructions	Application	Expand	Ã	â	€	™	Å	"EDITÃ	¢	¬	¬	¬	Ã	¢	Ã	¢	Ã	¢	¬	Å"	Preferences	â,	¬	Ã	¢	â,	¬	Å	"Performance	Â,	¬	to	ensure	the	quality	Ã	¢	¬	Å	"VerÃ	¢	â,	¬	=	Ã	¢	â,	¬	Å"	Bilinear	(the	best	quality)	Ã	¢	â,	¬	Å	"DÃ	¢	gradients,	¬	=	proven	Ã	Â,	¬	å	"Render:	Nvidia	GPU	Ã	¢	â,	à"	Retina
RepresentationÃ	¢	¬	=	Ã	¢	â,	¬	å	"OMATIC	AUT	"=	Revision	of	the	default	application	location	and	executable	name	C:	\	Executing	Files	\	Agisoft	\	Metashape	Pro	\	Metashape.exe	Instructions	of	the	Global	Navigation,	select	Ã,	drop-down	menu	¬,	and	Ã	¢	â,	¬	å	"Preferences	¢	â,	¬	Select	the"	GPU	"tab	Make	sure	the	check	box	is	reviewed	only	next
to	the	location	of	the	NVIDIA	GPU	default	application	and	the	executable	name	C:	\	Files	of	Program	\	Graphisoft	\	ArchiCAD	2	#	\	archicad.exe	Instructions:	Select	the	tab	"3D	/	All-"	at	the	top	of	the	top	window,	click	right	anywhere	in	the	window.	From	the	Sall	Out	menu,	select	"Bassic	(vector),	from	the	style	menu	and	in	the"	3D	"deployment,
select"	Copengl	",	select"	Shadow	(vector).	"From	the	style	menu	and	deployment	of	the	engine	"3D,	select"	OPENGL	",	select"	Technical	drawing	"of	the	style	menu	and	in"	3D	engine	""	3D	"	Select	"Copengl"	Select	OK	to	save	the	default	application	changes	and	the	executable	name	C:	\	Program	Files	\	Autodesk	\	Arnold	\	Maya20	##	\	arnold.exe
Double	check	instructions	that	the	MTOA	add-in	is	enabled	EN:	From	the	top	menu,	select	"Vestibulate">	Ã	¢	â,	¬	å	"Settings	/	Preferences	¢	â,	¬>	Plugin	Manager:	Turn	on	the	RTX	accelerated	ray	outlift	in:	From	the	top	menu,	select"	Hands	".	"Liberation	configuration".	In	the	Render	configuration	window,	select	the	tab	"System	system	in	the
Rendering	Device	field,	select"	GPU	"to	activate	AI	Denoising	for	rapid	interactive	playback:	In	the	Render	configuration	window,	select	the	ESTAIN	AOVS	Expand	the	"OptiX	Denoiser"	section	and	check	the	"Made	of	Beauty	Aov"	box	to	switch	between	beauty	and	a	render	Denoised:	Start	the	Render	by	clicking	on	the	playback	button	on	the	Arnold
RenderVIK	click	on	the	menu	drop-down	on	the	Arnold	RenderVIK:	(Denoise	Won	'T	appears	unless	the	render	has	begun)	Location	of	the	default	application	and	the	executable	name	C:	\	Program	F	Iles	\	Autodesk	\	AutoCAD	20	##	\	Acca.exe	instructions	Application	"	N	Create	a	blank	document	Select	the	drop-down	arrow	of	the	Autodesk	icon,
select	"PAGE",	select	the	"System"	key.	Select	"Choose	Graphics	Performance".	Under	Ã	¢	â,	Â	Å	"Acceleration	Hardware	³	¢	â,	¬	Be	sure	that	the	"stability	acceleration"	is	configured	in	"2D	display	configuration"	is	set	to	"Advanced	Mode",	all	options	must	be	selected	all	options	in	the	default	3D	display	setting	location	of	Application	and	Executable
Name	C:	\	Program	Files	\	Autodesk	\	Maya20	##	\	BIN	\	Maya.exe	Windows	Instructions	->	Settings	/	Preferences	->	Preferences	Click	on	the	category	Ã	¢	Ã	¬	å	"DisplayÃ	¢	â,	¬	Å"	Viewport	2.0Ã	¢	â,	¬,	Select	"Engine	Rrendering	Motor",	select	"DirectX	11"	Click	on	"Playback	Cage	"In	the	category	in"	Red	hot	play	",	select"	Preferable	",	drop-down
and	select"	Viewport	Hardware	Cache's	Click	Ã	¢	â,	Å	"GPU	cache	Ã	¢	â,	¬	category	in"	Advanced	Screen	Configuration:	UV	Coordinates	(Unmark	)	Ignore	UVS	in	the	GPU	cache	Read	/	write	(unmarking)	(Unmark)	Caching	/	playback	To	select	hardware	cache	storage:	Right	click	on	the	cache	storage	icon	at	the	bottom	right	of	the	timeline	to	reveal
options.	In	the	Render	configuration	window,	in	the	"Render	Using"	field,	select	"V-Ray".	To	light	the	dynamic	cache	storage	for	NCLoth	and	NPARTICLE:	Click	with	the	right	button	on	the	cache	"Select"	Player	Preferences	",	check	the	DINO	CACE	storage	option	Mica,	you	must	see	a	red	bar	that	is	filled	in	the	timeline.	In	the	output	mode,	select
"Advanced"	in	Streaming	Select	encoder:	"NVIDIA	NVICE	H.264	(new)"	Visual	Girling	Psycho	Look	forward:	in	frames	B	->	3	Leave	other	settings	in	Default:	Rate	Control:	Interval	of	Key	Frames	CBR:	0	Preset:	Quality	Profile:	High	recording	Table	Encoder:	NVIDIA	NVICE	H.264	(new)	Recording	Format	->	Select	MP4	MP4	Stream	Encoder	Leave
other	settings	By	default:	Location	of	the	default	application	and	executable	name	C:	\	Program	Files	\	Allegoríthmic	\	Alchemist	Substance	\	Substance	Alquermist.exe	Complete	GPU	/	CUDA	acceleration	instructions	By	default,	without	initialization,	on	in	the	image	of	AI	powered	on	the	material,	drag	any	image	file	to	the	Right	side	of	the	user
interface,	which	will	make	the	image	to	the	UI	of	the	pop	up	material	Click	the	fall	below	the	image	to	the	image	icon	to	the	material	and	select	"Powered"	from	the	drop-down	menu,	click	OK	Default	Location	of	the	application	and	name	of	the	executable	C:	\	Program	Files	\	Substance	Designer.exe	Instructions	(V2020.2	+)	When	you	start,	select
Motor	Subta	â,	¬	Ã	¢	â,	¬	å	"Direct3D	11Ã	¢	â,	¬	Ã	¢	â,	Å"	Edit:>	Select	Ã	¢	â,	¬	Å	"Preference	Ã	¢	â,	Å	"BakersÃ	¢	¬	¬	From	the	left	side	menu	(GTX	10	and	RTX	GPU	series)	select"	Enable	GPU	Raytraction	'Select	tab	(All	GPUs)	Deselect	Deselect	Ã	¢	Ã	©	Å	"CPU:	Select	the	NVIDIA	GPU	Click	OK	to	accept	changes.	In	the"	Production	Rendering
"section,	configure	the	RTX	production	engine,	the	Render	Render	Device	Selection	section	will	be	below.	Level	CQ:	20	Interval	of	Frames	Key:	0	Preset:	Quality	Profile:	High	Default	Application	and	the	executable	file	c:	\	Program	Files	\	Otoy	\	octanegerender	\	octane.exe	Instruction	File	->	Preferences	Select	Ã	¢	â,	Å	"DevicesÃ	¢	â,	¬>	Make	sure
that	both	GPUs	(All	Nvidia	GPUs	They	are	selected	to	render)	RTX	Backend	->	Select	Use	RTX	Accelection	Default	Location	of	the	application	and	name	of	the	executable	C:	\	Program	Files	\	On1	\	On1	Photo	RAW	20	##	\	On1	Photo	RAW	20	##.	INSTRUCTIONS	EXE	Select	the	"Global	Navigation	Menu,	select"	SPREEFERS	".	Select	Ã	¢	â,	¬	å"
SystemÃ	¢	â,	¬	below	the	submenusion	Ã	Ã	Ã	â?	​¬	Ã¢	â​¬	Ã¢	â​¬	Ã¢	â​¬	Ã¢	â​¬	Å​	banda	rÃ¡pidaÃ¢	â​¬	=	comprobado:	vista	previa	rÃ¡pidaÃ¢	â​¬	=	comprobado	Ã¢	â​	¬	å	"GPU	RenderyÃ	¢	â,	¬	=	default	application	of	the	location	and	executable	Name	C:	\	Program	Files	\	RedCine-x	Pro	64-Bit	\	RedCine-X	Pro.exe	Gobal	Instructions	NAV,	Edit	->	Pasta
System	of	preferences	Select	Ã	¢	â,	¬	å	"CUDAÃ	¢	â,	¬	from	the	drop-down	menu	under	the	GPU	mode	selection	REDSHIFT	Rendere	for	Cinema	4D	OptiX	enablement	(RT	/	AI)	in	experimental	instructions	(public)	RedSPIFT	Build	Install	Cinema	4D	after	installing	RedShift	Renderer	for	Cinema	4D.	Launch	Cinema	4D	Select	Render	Setting	->	In	Ã	¢
â,	¬	Å	"Render	using	¢	â,	¬	Select	REDSPIFT	Click	on	the	rendering	to	ensure	UI	updates,	then	Click	In	"System"	scroll	down	on	the	UI	menu	and	select	Ã	¢	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã	Ã
Ã	Ã	Ã	Ã	Ã	™	INSTRUCTIONS	Download	Install	RedShift	Renderer	for	Maya	and	then	launch	Maya	Render	Setting	->	Ã	¢	â,	Â	Å	"Render	using	â,	Ã	â,	¬	Å"	DSHIFTÃ	Ã	Ã	Ã	Ã	â,	¬	¬	¬	selected	Ã	¢	Â,	¬	Ã	¢	â,	¬	Å	"SystemÃ	¬	¬	¬	¬	¬	Å"	Experimental	Options	"->	Select	Ã	¢	â,	¬	å"	Enable	OptiX	RT	in	GPUs	compatible	'below	Ã	Ã	Ã	Ã	Ã	Ã	¢	Å	"Flobal
Preferences	¢	â,	¬	Select	all	the	location	of	the	default	nvidy	GPU	application	of	the	application	and	the	name	of	the	executable	C:	\	Program	\	SketchUp	\	SketchUp	20	##	\	SketchUp.exe	Instructions	Menãš	Top,	Ã	¢	â,	¬	å	"WindowÃ	¢	â,	¬,	select	Ã	¢	â,	¬	å"	PreferencesÃ	¢	â,	¬	Left	lateral	navigation	Select	Ã	™	â,	¬	å	"Peen	GlÃ	¢	â,	Nonless	to
Deselect	or	Select	Automatically	Select	the	GPU,	Multi	Shows	4x	Details	of	the	Graphic	Card:	Indicates	the	location	of	the	default	application	of	the	GPU	and	the	executable	name	C	:	\	Program	Files	\	StreamLabs	OB	\	StreamLabs	OBSEE	INSTRUCTIONS	INSTRUCTIONS	Ã	¢	â,	¬	å	"SettingsÃ	¢	¬	¬	on	the	left	on	the	bottom	left	of	the	screen	Select
the	section	Ã	¢	â,	à"	outputÃ	â,	¬	on	the	left	side.	Keyframe	interval:	0	Preset:	Quality	profile:	High	under	recording:	Encoder:	NVIDIA	NVICE	H.264	(new)	Recording	format:	Select	"MP4".	Turn	on	the	look	forward	and	the	visual	psycho	adjustment	increase	to	3.	In	the	sub-tab	of	the	frame,	set	the	renderer	to	MPATH.	Yellow	for	disabled,	or	not
supported.	Select	the	cache	storage	icon	in	the	lower	right	part	of	the	timeline.	Timeline	

03/10/2018	·	例）Windows版	Version1.44のファイルは、photoscan-pro_1_4_4_x64.msi	...	P4RTK	UAV測量設定Manual	633	...	Agisoft	Metashape	2022年4月9日	RealityCapture	2022年4月9日	RealityCapture	サポート	09/12/2020	·	Introduction.	If	you	are	one	of	the	lucky	folks	who	have	managed	to	get	one	(or	several)	of	the	new	NVIDIA	RTX3090	or	RTX3080
GPUs	and	are	wanting	to	do	some	ML/AI	work	with	TensorFlow	1.15	you	may	have	run	into	some	trouble!	23/12/2017	·	PHANTOM4	RTK	UAV測量設定Manual	620件のビュー;	第1回	Agisoft	Metashape（旧PhotoScan）チュートリアル	479件のビュー;	Litchiの使用方法-General-444件のビュー;	点群ソフトウエアMetashapeに必要なPC性能と設定	430件のビュー;	第1回
UAV測量ソフトMetashapeとPix4Dの比較	415件のビュー
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